Updating an EAD File
Using XEAD and CONTENTdm

Use this procedure to change an existing EAD file. You will use the XEAD tool to change the EAD file and then
use CONTENTdm Acquisition Station to replace the file on the CONTENTdm server and to edit the metadata.
(To import and upload new EAD files to CONTENTdm, do not use this procedure. Instead, see the procedure
on “Using CONTENTdm’s Multiple File Import Feature to Import EAD Files.”)

Editing an EAD File in xEAD

1. Identify the Collection Number of the EAD file you need to edit. If you don’t already know the Collection
Number (e.g., UU_Ms0509.xml), you can find it on the EAD file online. Locate the EAD to be updated in
CONTENTdm and open the item. Make a note of the Collection Number — in this case, UU_Accn1165.
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2. Double-click the Desktop Apps folder on your desktop.
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3. Double-click the xEAD.jar file. The XEAD program opens.

File Edit Wiew Faworites

Tools  Help

=10 ]

| .'\:l

0= ©

j_)Search i Folders

Y

Address I@ 5:\Deskiop Apps

H8e

File and Folder Tasks

Iim Rename this file
[ Mave this File
D Copy this file

&3 Publish this file to the
Web

=) E-mail this file
¢ Delete this file

Other Places

¥ production on

'db3-sgl\Deskiopapplicat

(51
E' My Docurments
i My Computer
\-':g My Mebwork Places

Details

READ.jar
Shorteut

& | hame = Size | Type | Date Modified
S ﬁ Ask Librarian 1 KB Internet Shortcut  1f22/2008 331 PM
ﬂ Colllection Developrment 1KE Internet Shortcut  5/21/2008 3:52 PM
ﬂ Consulkation Reporting 1 KB Internet Shortcut  9030/2008 11:04 AM
@Database of databases 1KE Shorteut 121192006 5:53 PM
E‘ﬂ Diesk Statistics 1kB Internet Shortcut 97172007 11:43 AM
ﬂ Emergency Training 1 KB Internet Shortcut  5f21/2008 3;52 PM
@Friends of the Library 1KB Sharteut 12192006 5:52 PM
@Giﬂ:s 1KE Shorteut 12/19/2006 5:51 PM
@Human Resources 1KE Shorteut 121192006 5:51 PM
@Inventory 1 KB Shortcut 12/19/2006 5:51 PM
ﬂ Job Lisk 1KE Internet Shortcut 502172008 352 PM
& i@lKey DB 1KB Intermet Shortcut  5/21/2008 3:52 PM
ﬂ Librarian Leave 1KE Internet Shortcut 502172008 3;53 PM
@Library Safety and Security 1KB Sharteut 5/4/2007 11:01 AM
| Newspapers 1KE Shorbcut 12119/2006 5;50 PM
@PC Systems App 1KE Shorteut 712112008 10:19 AM
@Records Management 1 KB Shortcut 12119}2006 5:36 PM
; 1KE Shorteut 1/22]2007 1:48 PM
< 1KB Sharteut 10/13/2008 4:43 PM

»

[

4. From the File menu select O:en.
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Navigate to the EAD file to be updated, on the O: drive in your division’s EAD/archived folder (for this

training session, use O:/Everyone/EAD-test instead). Select the file and click Open.
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7. Browse to the section to be edited by clicking the section title in the navigational panel at the left. In this
example, we are going to add a new subject in the Controlled Access section, so click “Control Access” at
the left.
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Remove subject=Graduate School of Social Work - Study and Teaching - Utah - History - Sources;;source=null
subject=University of Utah -- Curricula;;source=null
subject=University of Utah. Graduate School of Social Work;;source=null
genre=brochures;;source=null

genre=correspondence;;source=null

genre=grant applications;source=null

genre=handbooks;source=null

genre=lists;;source=null

genre=memoranda;;source=null

genre=minutes;source=null

genre=news articles;;source=null

genre=newsletters;;source=null

genre=reports;source=null

genre=videotapes;source=null

8. Add the additional information or correction. In this example, we will add two new subject terms from the
UMA Browse Topics list. First, add “Education” as a UMA broad topic. Type “Education” in the Subject
term field and select “UMAbroad” from the Subject source dropdown list.
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9. Click “Add Subject”. The new subject term appears in the list of subject terms and genres.
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10. Similarly, add the UMA narrow term of “Colleges and Universities.” Click “Add Subject”. The new subject
terms appears in the list
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11. In the File menu select Save As.
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12. Navigate to the “replace in CONTENTdm” directory in your division’s EAD folder on the O: drive (for this
training session, use O:/Everyone instead). Click Open to open the folder. Click Save to save the file. Do
*not* rename the file.
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13. In the File menu select Exit. The XEAD program will close.
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Replacing the Edited File in CONTENTdm

1. Open CONTENTdm Acquisition Station. Click “Open” to access the existing projects list.
CONTENTdm Ac ion Station
T = .',»:' i
0.0 CONTENTdm e
e T I R e S
2. Select your EAD project from the list. Click OK. The Project Workspace opens.
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3. Click the magnifying glass icon (or from the Import menu select “Search Collection”) to open the Query
Collection. We are going to pull the item we want to change from the CONTENTdm server to the
Acquisition Station.

CONTENTdm Acquisition Station

Edit Import Full solukion  Tools  Imaging  Administration Help

Search Collection

=W Project - xEAD test Collection - Sandra’s Test

Title Repository Subarea Collection Mumber
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4. The easiest way to retrieve the item we want is by Collection Number. On the “Search Selectable Fields”

tab panel, click the down arrow to the right of “Title” and select “Collection Number”.

CONTENTdm Acquisition Station
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agnes

albion

Title LJ | almeron
Title: ~ and
F.epository | anderson
Subarea arakaki
ollection Mumbrs | arrny
Genre or Farm associabion
Creator ]

Contributor

Date {

Sort Results By: |Title = Hew Ssarch E:i&imd

|
[

Search Resulks

5. The panel to the right displays values already entered in the field, so you can double-click any of the values
in the list to fill in the Collection Number or you can type the number into the field. The example shows the
replacing of A0286.
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6. Click the Search button. The Search Results display, in this case with one item meeting the search criterion.
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7. Double-click the thumbnail or click Grab Set to bring the EAD item into the Project Spreadsheet.
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8.

10

Click “X” at the top right to close the Query Collection.

CONTENTdm Acquisition Station
File Edit Import Full Resolution Tools Imaging Administration Help
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Project - xEAD test  Collection - Sandra's Test
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Double-click the thumbnail to open the item.
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B Japanese-American Citizen's League (JACL) AV Collection

<7xml wersion

.0" encoding="UTF-8" 7>
- <ead mins="urn:isbn:1-931666-22-9" xmins: zsi="http:/ /www.w3.0rg/2001/XMLSchema-instance"
wmins: xlink="http:/ /vww . w3.org/ 1999/ xlink" xsi:schemalocation="urn:isbn:1-931666-22-9 http://www.loc.gov/ead/ead .xsd">
«!-- Last Edited: 2008/08/21 16:22:33 by xEAD vBETAL 07-14-2008 -->
- <gadheader langencoding="is0639-2b" scriptencoding="is015924" relatedencoding="dc" repositoryencoding="iso15511"
countryencodin 503166-1" dateencoding="iso8601">
<eadid countrycode="US" mainagencycode="US-UUML" publicid="-//::/ /TEXT{(US ::UUML::UU_AD286.xml::)}/ /EN"
encodinganalog="identifier'>UU_AD286</cadid>
- <filedesc>
- <titlestmt>
- «titleproper encodinganalog="title">
Japanese-American Citizen's League Collection
«<date era="ce" calendar="gregorian" encodinganalog="date" />
</titleproper>

=¥ Media Editor

<titleproper type="filing" altrender="nodisplay" />
<author encodinganalog="creator'>Tawnya Mosier</author> Edit Metadata Controlled Vocabulary
</titlestmt=
- <publicationstmts This field does not have a contralled vocab)
<publisher encodinganalog="publisher'=audio-visual Archives, J fre Ibapanese-American Citizen's League (JACL) A Callection
</publicationstmtz Repository 2. willard Marrictt Library, University of Utah
</filedesc> s
- <profiledesc [Su &l I
- <creations [ollaction Mumber [00_aazee
Tawnya Mosier Fenrauerm T
«date era="ce" calendar="gregorian" normal="">16 March 2004«
</creations Frmmf |mas Hashimato; Trene Mori (3ACL)
- <langusage> ) ontributor |
<language encodinganalog="language" scriptcode="Latn" |angcodg
</langusages> pate [1920; 1921; 1922; 1923 1924; 1925; 1926; 1927
</profiledesc Puénugy [
Click to open a Web broy Fﬁﬂ_g ‘ IEnghsh) Japalioss
F;g:;r_m_kmn \(Chronological and by Subject. ; <i=0ur Mawy in the World
war

Fubiett [
Feog'raphr:a[ Hames |
run:;r'an |

|

[occupation

Bl

Enter data into the metadata fislds. You must complets the Titls fisd, Searchable
fields are highiiaht=d.

Thumbnail Permissions

£ Bak | Save | Save & Next Cancel

T T TeEre T T

1 Objects




10. Click the display window behind the Media Editor to bring it to the front.

CONTENTdm Acquisition Station

Tnport Ful Resolution Tools Imaging  Administration Help
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<?uml version="1.0" encoding="UTF-8" 7>
- <ead smins="urn:isbn:1-931666-22-9" xmins: xsi="http:/ /www.w3.0rg/2001/XMLSchema-instance"
wmins: xlink="http://www.w3.0rg/1999/xlink" xsi:schemalocation:
«l-- Last Edited: 2008/08/21 16:22:33 hy xEAD vBETA 07-14-2008 -->
- «zeadheader langencoding="is0639-2b" scriptencoding="iso15924" relatedencoding="dc" repositoryencoding="iso15511"
countryencoding="is03166-1" dateencoding="iso8601">
<eadid countrycode="U8" mainagencycode="US-UUML" publicid="-//::/ /TEXT{US ::UUML::UU_AD286 xml::)/ /EN"
encodinganalog: entifier'=UU_AD286</eadid>
- <filedesc>
- <titlestmt>
- <titleproper encodinganalog="title">
Japanese-American Citizen's League Collection
=date era="ce" calendar="gregorian" encodinganalog="date" />
</titlepropers
<titleproper type="filing" altrender="nodisplay" />
<author encodinganalog="creator'>Tawnya Mosier</authors
</titlestmt=
- <publicationstmt>
<puhblisher encodinganalog="publisher">Audio-Visual Archives, 1. Willard Marriott Library, University of Utah</publisher>
</publicationstmt>
«/filedesc>
- zprofiledesc>
- <creations
Tawnya Mosier
=date era="ce" calendar="gregorian" normal="">16 March 2004</date>
Z/creations
- <langusage:>
<language encodinganalog="language" scriptcode="Latn" langcode="eng" />
<flangusage:>
</profiledescs>

Click to open a Web browser ko view the ikem,

"urn:isbn:1-931666-22-9 http://www.loc.gov/ead/ead.xsd">
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|
[unction |
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Becpation
=

Enter data inko the metadata fields, You must complete the Title fisld, Searchable
fields are highiiaht=d.

Thumbnail Permissions

Save & Next Cancel

11. In the Edit menu select Replace Item.

CONTENTdm Acquisition Station

Ful Resolution  Tools Imaging Administration Help

ing="UTF-8" 7>
31666-22-9" xmins: xsi="http:/ /www.w3.0rg/2001/XMLSchema-instance"
w.w3.org/1999/xlink" wsi:schemalocation="urn:ishbn:1-031666-22-9
ead/ead.xsd">
5/08/21 16:22:33 hy xEAD vEETA 07-12-2008 --%>
9="i50639-2b" scriptencoding="iso15924" relatedencoding="dc" repositoryencoding="isn15511"
3166-1" dateencodini soB601">
'US" mainagencycode S-UUML" publicid="-//::/ /TEXT(US :UUML::UU_A0286.xml:)/ /EN"
encodinganalog="identifier'>UU_AD286</cadid>
- <filedesc>
- «titlestmt>
- «<titleproper encodinganalog="title"=
Japanese-American Citizen's League Collection
<date era="ce" calendar="gregorian" encodinganalog="date" />
</titleproper>
=titleproper type="filing" altrender="nodisplay" />
=author encodinganalog="creator"=Tawnya Mosier</author:
=ftitlestmt>
- <publicationstmts>
=publisher encodinganalog="publisher">Audio-Visual Archives, 1. Willard Marriott Library, University of
Utah</publishers
</publicationstmtz
«/filedesc>
- zprofiledesc>
- <creations
Tawnya Mosier
=date era="ce" calendar="gregorian” normal="">16 March 2004</date>
</creation=
- <langusages

Add Test File
Add OCR. Text

|

Click ko open a Web browser to view the item,

1920; 1921; 1922;
1923; 1924; 1925;
1926; 1927; 1928;
192%; 1930; 1931;

Description (Chronological and by Sublect.; <i>Our Navy in the World
ar

Contralled Yocabulary

w0t have a controled vi

11



Update and Replace

12. The Replace Item box opens. Click the Browse button.

tONTENTdm Acquisition Station

File Edt Import Full Resolution Tools Imaging Admimistration Help
7 =
%3 ® Q
¢

N Japanese-American Citizen’s League (JACL) AV Collection

<?xml version="1.0" encoding="UTF-8" 7> 1920; 1921; 1922;

- <ead xmins="urn:ishn:1-931666-22-9" xmins: xsi="http://www.w3.org/2001/XMLSchema-instance" :3521 :35;1 13521
amins: xlink="http:/ /www . w3.0rg/1999/xlink" xsi:schemalocation="urn:isbn:1-931666-22-9 19293 193[.3 19313

http://www.loc.gov/ead/ead.xsd">
<l-- Last Edited: 2008/08/21 16:22:33 by xEAD vBETA 07-14-2008 -->
- <eadheader langencoding="is0639-2b" scriptencoding="iso15924" relatedencoding="dc" repositoryencoding="iso15511"
countryencoding="iso3166-1" dateencoding="iso8601">
<eadid countrycode="US" mainagencycode="US-UUML" publicid="-/7::/ /TEXT(US::UUML::UU_A0286.xml::}/ /EN"
encadinganalog="identifier"sUU_AD286+</zadid>

- <flledesc>
- <titlestmts Replace ltem

- <titleproper encodinganalog="title">
Japanese-American Citizen's League Collecy
<date era="ce" calendar="gregorian" encoding,

</titleproper= File nams:
<titleproper type="filing" altrender="nodisplay" /: — 'm
<author encodinganalog="creator'>Tawnya Mosi| [~ apply Template Creator settings to replaced item

</titlestmtz T

- <publicationstmts>
<publisher encodinganalog="publisher'>Audio-V¥i:
Utah</publisher>
«</publicationstmtz>
=/filedesc>
- <profiledasc>
- «creationz»
Tawnya Mosier
<date era="ce" calendar="gregorian" normal="">¥ click Advanced to access the Template Creator,
«foreation>
- <langusage> )

Click b opery Ed 3 Cancel

Chronological and by Subject.; <i0ur Nawy in the World
War

Choos file to replacs existing image.

is field does not have a

13. Browse to the location of the edited EAD file on the O: drive, in the “replace in CONTENTdm” directory
on your division’s EAD folder (for this training session, use O:/Everyone instead). From the dropdown list
of “Files by type,” select “ALL (*.*)” to see all the files in the director

ﬁ CONTENTdm Acquisition Station

File Edit Import FulResolution Tools Imaging Administration Help

&3 M@ D)

apanese-American Citizen's League (JACL) AV Collection

<?uml version="1.0" encoding="UTF-8" ?> ; 1921; 1922;

- <ead #mlns="urn:isbn:1-931666-22-9" xmins: xsi="http:/ /www.w3.0rg/2001/XMLSchema-instance" 132;4 ggg'
zmins: zlink="http:/ /vww.w3.0rg/1999/xlink" xsi:schemalocation="urn:isbn:1-931666-22-9 i lgauj 1931;

http://www.loc.gov/ead/ead.xsd">
<l-- Last Edited: 2008/08/21 16:22:33 by xEAD vBETA D7-14-2008 --%

- zeadheader langencoding="is0639-2b" scriptencoding="iso15924" relatedencoding="dc" repositoryencoding="iso15511"
countryencoding="iso3166-1" dateencoding="iso8601">
<eadid countrycode="US" mainagencycode="US-UUML" publicid

encodinganalog="identifier'>UU_AD286</cadid>
- =filedesc
- <titlestmt>
- <titleproper encodinganalog="title">
Japanese-American Gitizen's League Collecy
<date era="ce" calendar="gregorian" encoding, »

=/ F i/ S TEXT(USIUUML::UU_AD286.xml:)/ /EN"

Look in: | 3 AEAD-RMLiles

| DisplayReplace

=/titleproperz= \

«<titleproper type="filing" altrender="nodisplay" /- ef‘ 'm

<author encadinganalog="creator'=Tawnya Mosil  ppRecent
</titlestmt> Documents This field does not have a control

- <publicationstrmts
<publisher encodinganalog="publisher'>Audio-Vi @

Utah</publisher>
</publicationstmt> Desktop
«/filedesc

- <profiledesc> ,.\'.
- <creation> g
Tawnya Mosier

<date era="ce" calendar="gregorian’ normal="">3 MvDacuments
<fcreationz
- <langusage: b

My Computer  File name: | =l \ﬂl

ey Fies ol ype [Images("pa."ai] =l Cancel |
Tmagesjpa. )
Full Resolution[* . tiff, " jpg]
Moviesf* m .

AL

Fmiec}
Feog’raph’cal-'ﬂan‘i_as [
run:t\"on i |

Click ta opery

12
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~Japanese-American Citizen's League (JACL) AY Collection

<?aml version="1.0" encoding="UTF-8" 7>
- <ead «mins="urn:isbn:1-931666-22-9" xmins: xsi="http://www.w3.0rg/2001/XMLSchema-instance"
amins: xlink="http:/ /weww . w3.0rg/1999/xlink" xsi: schemalocation="urn:isbn:1-931666-22-9
http:/ /www.loc.gov/ead/ead.xsd">
«l-- Last Edited: 2008/08/21 16:22:33 by xEAD vBETL 07-14-2008 -->
- <eadheader langencoding="is0639-2b" scriptencoding="iso15924" relatedencoding="dc" repositoryencoding="iso15511"
countryencoding="is03166-1" dateencodin s08601">
<eadid countrycode="U8" mainagencycode="US-UUML" publicid="-//::/ /TEXT(US::UUML::UU_A0286.xml::}//EN"
encodinganalog="identifier"=UU_AD286</cadid>
- «filedescs>
- «titlestmts>
- <titleproper encodinganalo itle">
Japanese-American zen's League Collect

Look in: | £ sEADHMLiles

1920; 1321;
1923 1924;
1926;
1929,

| DisplayReplace
[2] ead-to-cdm-extraction. et

«date era="ce" calendar="gregorian' encoding T
</titlepropers> 7
<titleproper type="filing" altrender="nodisplay" /-
<author encodinganalog="creator'>Tawnya Mosi My Recent

</titlestmtz Documents

- <publicationstmtz
<publisher encodinganalog="publisher"»Audio-Vi @
utah</publisher=
=/publicationstmts> Desktop
=/filedescs>
- <profiledescs>

s ad-to-cdm-extraction_v12 wbs
UHi_BO00S_edited. il
ULA_pO318.xml

) UOW_M512_edited.xl
ULI_AD286.

3 UL_P 1086 5l

- <creation:
Tawnya Mosier
<date era="ce" calendar="gregorian’ normal="">% MsDacuments

<focreations
- <langusage> ]

Click to opery -
My Corpiter — File niame: | |

Files of type

e

Open |

Cancel |

L4 Look in: | I »EAD ><MLflles -1 =% B
E | DisplayReplace
# ead-to-cdm-exkraction. kxt ]
3 + ead-to-cdmesxtraction_w12.vbs I
" by Recent /2" UHI_BOO0S_edited. <rnl -
B cUbhits 20 ULA_pD318.xml
B @ oW _MS12_edited. xml
u
Desktop
4 My Documents
" )
My Compiiter  File name: |0U_anzas emi =1 Dp_le"‘
T Files of tppe: | ] ~1 Cancel |
T 5l

The file path you specified displays. Click OK.

Replace Item r;

Choose file to replace existing image.

File name: !‘r’:'I,AnneM'l,cdmtraining'l,xead'l,DEMO_?B'l,xEA[

i [ &pply Template Creator settings to replaced item

¥ Click Advanced to access the Template Creator.

Advanced I oK Cancel I

Update and Replace

13



Update and Replace

17. A warning box opens. Click Yes. You have now replaced the EAD file on the CONTENTdm server with the
new, updated file.

This will permanently replace the current item, Do you wish to continue?

Es Mo

Updating the Metadata in CONTENTdm

Important: The metadata record in CONTENTdm must be updated also.

1. Locate the appropriate metadata field in the template and type in the updated information.

T9Z9, T930; 1931

by xEAD vEETA 07-14-2008 -->
iptencoding="is015924" relatedencoding="dc" repositoryencoding="iso15511"
ding="iso8601">
He="US-UUML" pub,
B6</eadid>

¥ Media Editor.

I Edit Metadata — Contralled Yacabulary

s nok have a controlled vocabulary

ague Collection -
9 | iTIUE Dapanese-american Citizer's League (JACL) AY Callection

pn" encodinganalog

FEDUSitUW 17, ‘willard Marriatt Lintary, University of Lkah

nodisplay" /> [ubarea |
rawnya Mosier</a

(Collection Number UU_anza6

JGenre or Form |
Br'=Audio-Visual 4

Freator !Mas Hashirato; Irene Mori {JACL)
[Cantributor |
Pate ilQZDj 1921; 1922; 1923; 1924; 1925; 1926; 1927;
JQuantity |
- i_anguage IEninsh; Japanese

" normal="">16 Ma

Pescriptinn Chronalogical and by Subject.; <i=Cur Nawy in the World
War

Click ko open a web

iSubjact

Fengraphical Mames

|

I ‘
runctinn |

| |

T

Pccupation

Enter data into the metadata fields. You must complete the Title field, Searchable

fields are highlighted,
| Save I Save & Next Cancel

Thurnbnail Permissions

14



Update and Replace

2. Click Save. The Media Editor closes.

CONTENTdm Acquisition Station
Edit Import FulResoltion Tools Imaging Administration Help

5 &/ @ | )

=¥ Project - xEAD test  Collection - Sandra's Test

Genre or Form

3. Click the Upload button at the bottom right.

Huld | Celete | pload

A progress bar displays during the Upload process. “Upload successful” displays. Click OK.

CONTENTdm Acquisition Station

File Edit Import Fol Recolition Tools Imaging  Administration  Help
o o
8 S D)

] Project - xEAD test  Collection - Sandra's Test [- "EI”

Repository Colection Number Contributor [ae  [ouamy

Upload Successful

You have successfully uploaded an item ko the pending queue, It must be reviewed and approved before it is added to the collection,

QK

15
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Update and Replace

E CONTENTdm Acquisition Station JPEG2000

In the Administration Menu, select CONTENTdm Administration.

Fle Edt Import FulResoltion Tools 1macno

About Collection

Pending Campound Chiects
=¥ Project - xEAD test  Collection - Sandra's Test

Repasiary Collection Nurber Contribusor

Quantity

Hold Delete

Upload




Update and Replace

7. On the “items” menubar, click “approve”.

B4 CONTINT dm Acquisitian Statin JPLGZ000

4 CONTINTdm Administration

c-|-»omf.&
Back | Mest Pefresh | Home

i!’ NTENTdm Administration

turrent collection: [Sandin's Tast

1t administration

Approve
Approve, odd or doletn iterrs in o pending queue.

Tk

Irsdex the collection after adding, approving, editing and deletng fems.

Add

Add an e to the pending queus, Items are reviewed and spproved bafore bacoming part of the collaction,

Ldit
Edit and delete Rems in & collection.

Find & replace
Find and replsce metadata within one field, o8 fields, or change fields for all items.

Lack administration
Unlodk ibems in a collechion.

Winw collection

Wimw ciarrant collaction in the Web temglate et scs.

8. Click “Approve All” or, if you have more than one item to be approved, approve them one at a time by
clicking “edit” to the right of the title and “approve” on the item.

8.4 CONTINT dm Acquisitian Station JPLGZ000

4 CONTINTdm Administration

c-|-»omf.&
Back | Mest Pefresh | Home

13 CONTENTdm Administration

|

Current collection: [Sandi’s Tas =l

Approve items

Review | prading item dnlete all | approve all
Apprave all &ems or revien tems individuslly before they are sdded to the collection.

Japanese-American Citizen's League (JACL) AV Collection edn

delete all | approve all

File namos
CONTENTdm ranarmns fins ta snsure data swegrity
& Ganerste uniqus fils name (recommendsd)

™ Retain origingl file name within generated file name

17



Update and Replace

9. Select “Index” and click “Start Index”.

¥ CONTENTdm Acquisitien Station JPLGID00

4~ CONTENTdm Administration
= Q[ &
Back | Meat Plreih | Home
D TENTdm At istration

Eurreal collection: [Sandra’s Test

Index

Index the collection once you have sdded or deleted Rems, or changed metadata within & collection. Indexing may
take several minutes. Wart for the completion message betore accessing other administration pages.

W CONTENT dm Acquisitian Statian JPEG2000

&= Q[ 6

Back | Mext | Rop [Refrech| bome
10 CONTENTdm Administration

Eurrent collection: Sandra's Tast

Index

g Subasas Fiald
Buding Collaction Number fiald
Buitding Ganre as Faom fiald
Building Creutor fald
Buding Curdributor fiald
Buidding Data fiald

Buiding Subjest fisld

huilding Gacgraphical Hamas fisld

Building Fundtion fiald

buiding Ceupation fiald

Buitding Accass Rastricsons fald
watrictivns fiald

Altarnative Formats avallable fisld

]
Buiding Date, digital fiald

18



Update and Replace

11. To check the EAD display, click “edit” on the items tab and on Search: “Selected Fields”.

K CONTINT dm Acquisitian Station JFLGID00 1

4 CONTENTdm Administration

)

ii:l CONTENTdm Administration
[admin home]——oT] crve ]

Current collection: | Sandra’s Tas

Edit

Browse or search for items you wish to edit, delete, export or add 1 cumpound objects.

searchi Across all fields | Selected finlds | By prosenty | By date browse collectic

Find rosults
All of the words ]
Theexactphesse [
T
Noneofthewards [

Display [50 ] resuts per page

TR T

12. Using the drop down menu select Collection Number.

T CONTENT dm Acquisitien Station JPLGID00

A CONTENTdm Administration

*l*o&
Back | Mot Bilrosh | Hiown

il:! CONTENTdm Administration

vimin homy|————— [isevan]

edit

Current callection: [Sandra's Test = =

Edit

Browse or search for items you wish to edit, delete, export or add to compound sbjects.

Sparch: Acreas all fields | Selected Flolds | By prazimity | By date brows

Find results
[ ol the weeds =1 [ in thn Im- -;ﬁ!'d show tarme
[eractphrase =1 inthe [Rapassen indd  show tarms

e
+ more hields | - fewer Finlds g::l,‘:“:.hr::a“

fubjact
Gucgraphical Mamai
Funszion

Occupation
Accars Rastrictions
x duailable

Format;
Ralatad Matarial

] Fapmst. umnl
ata. digital

19



Update and Replace

13. Enter the Collection Number of the EAD you just approved and indexed. Click Search.

8 CONTENTdm Acquisitien Station JPLG2000 ol

Ve ENTdm Administration

clelE e

r:a CONTENTdm Administration

edit
Eurrent collection: [Sandra’s Test

Edit

Browse or search for ikems you wish to edit, delete, export or 2dd t2 compound sbjects.

Sparch: Acreas all fields | Selected Flolds | By prazimity | By date hraws
Find results
[S0aT the werds =] [s028% inthe [Collaction Number =] ol shiw tnrene
[oxaaohrae =1 inthe [Tl =1/ feld show terme

+ more fields |~ fewer Finlds
Duesplay [30 =] resulte par pags

e Q[6| &
Back | Mt [ Rlroch | Home
10 CONTENTdm Administration

| e

edit

Current collection: Sandra's Test

Rusults: 1 items found

| Global sctions

Caution: These actions affect oll results. Deletion cannot be undone,

[t | oo | it hie oy s

Delete mode

This setting determines how compound objects are deleted.

 alate d objact only | Dalete i ubjact and s subsges

Selected aperations
select all : clear all : delets : sxport : add to compound object paga1ofl i << L >> )it pravious  next

Image: & Title: subject: Description:

lagiarese- Amessean Ciltieen's League Chronalogical and by Subpect.; Gur My metadata | delote
(IACL) AY Collection iy e Workd War

selnct all @ cloar all @ delote @ expart @ add to compound object

20
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15. If metadata needs to be updated or edited, apply the edit to the appropriate field. Scroll to the bottom and
click Save. The collection must be indexed in order to reflect changes made. To index collection click on
Index and “Start Index”.

9.3 CONTENT dm Acquisitien Statlon JPLGID00

# CONTENTdm Adminisiration

& =0 (a

Back | Meat LETEE

l:‘ CONTENTdm Administration

Edit item

Edt metadata then click save changes. To remave this item from the collection, click delobe. Afer making changes,
70U et rabild the teat mdex,

wiww this item

Tithe. wpanain-Armrican Clizar's Lasgus (JACL) AL

Repastory [1 willard Mot Libeary, Unisarsity of Ltah

Subsras [

Collection Number [ aezee

Genre o Form |

Creator [Mas Furhimota; trana Mo (1age)

Contributar [

Date [rozey 19211 1972 1933 1%a; 197 19

Quanity I

Languagn [Engtish: Jansnata

Description ’Eﬁmu!clnl and by Buljud. 1 <i>-Our Havy
the World War

collection: Sandra's Test

Rusults: 1 items found

Glubal actions

Caution: These actions affect oll results. Deletion cannot be undone,

TN R T

Delete mode
This setting determines how compound objects are deleted,

= oslate d object ealy 7 Dulete U ubject and s subpages

Selested operations

select all ¢ clear all : delete : sxport : add to compound object paga1ofl i << L >> )it pravious  next
Image: & Title: Subject: Description:
ra Japanese-Amercan Cibeen's Loague Chronological and by Subpect.; Sur Mawy metadata | delote
(IACL) AV Collection i the Workd War
'
EAD™

selnct all ¢ clnar all £ delotn @ export : add to compound object popedofl (€< 1 >3 )iz previous | next
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17. The EAD file displays.

i ; http:flcontent. lib.utah.edu - CONTENTdm Collection : Hem Viewer - Micrasofl Inter et "I|I|IIII!I
J.Willard Marriott Library
I THE UNIVERSITY OF UTAH
Special Collecrions e

Utah Statewlde EAD Tndex
Colleetion Overview 3] Mgl apjlimg

Collection Oyerview i
iocLlon UVOER ] [ I
Cellestion Inventary  FE] Titla: J.\x.\m»mm_a Citizen's Lasgua
« <i:0ur Navy in the Warld (JACL) AV Collection _ Erviemluwnbe |
Ware/is; <l5Lindbergh: Thy Dates: 192cs-1975 (inchusive)
E.ﬂ -Atlantlc Collection ULI_Acsfs
Flight=/I> Number:
Current Events Reel One Reposltory: J.:Ljﬂi:d Marriott Library, University of
urrent Events Real Two U
Current Events Riel Three
Current Evenls Feel Four
Current Events Reel Five | Collection Inventory 5]

anrmm“wamrh
c“‘;p"""' atBrighan = L vin |d War < iz} <izLindbargh: The Epic Trans-Atlantic Flight«/i=

i

Currant Events (lapanase
Title C. Y1 "

Foathall Reel One
Foathall Reel Twa
Basehall Resl One
Baseball Revl Two

Home Movi

Toyohachi (Hame Movie)
Home Movie

Home Movie US. (Utah?)
Home Movle

Ch Hloscoms and !
Iamﬂmf.‘nﬂmﬂum i L"M"”f

An Appeal for Action to .
O‘Marm:mrhn Redress

Content

G Use
Administralive Lnformation

L snservenoncin. st o e viz|.

BI%
! []
A O © BB G Lo Sy @ 25 3 - [
v Bo s ™ @

adress | hetn: ffeontant .t ah edufod s _viewsr . ho L ESORONT = ehet B IS0R TR =114 k

D
sdm| T
Content Description 5]

is & membership orga
and e

wepaper
i i key
from the official

of state or federal

T provi
ressarcher

Administrative Information &5]

Arrangement;

mote; Irene Mart (JACL)
Languaga:
EnglishJapanese
Language of the Finding Ald:
Author of the Finding Aid:
Tawnya Mosier

19. Move the edited EAD file to your division’s “archived” folder on the O: drive (for this training session, use
O:/Everyone instead). Overwrite the earlier file. The EAD file in your “archived” folder is now the same as
the one on CONTENTdm.
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Appendix A.
Additional CONTENTdm Help

Contentdm.com provides extensive tutorials and documentation.

1) To sign up go to http://contentdm.com/. Click the Users tab to register.
2) Register using your University of Utah e-mail address.

3) The organization ID for the University of Utah is UUT1003.

4) Once you’ve logged in, the tutorials and help files will be accessible.

Useful Help Files, available at http://contentdm.com/help4/index.html:

e Starting a new project:
http://contentdm.com/help4/acg-station/starting2.html

e Collection Administration
http://contentdm.com/help4/collection-admin/index.html

e Item Administration
http://contentdm.com/help4/item-admin/index.html

Useful Tutorials, available at http://contentdm.com/USC/tutorials/index.asp:

e Quickstart Guide
http://contentdm.com/USC/tutorials/quickstart-quide.asp

e Controlled Vocabulary
http://contentdm.com/USC/tutorials/controlled-vocab.asp

e Creating Compound Obijects
http://contentdm.com/USC/tutorials/compound-wizard.asp

Contacts:

Anne Morrow, Digital Initiatives Librarian
anne.morrow@utah.edu
(801) 581-8594

Kelly Taylor, Digitization Specialist
kelly.taylor@utah.edu
(801) 585-5587

Sandra Mclntyre, Program Director, Mountain West Digital Library
sandra.mcintyre@utah.edu
(801) 585-0969
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